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File Menu

The File menu includes commands that enable you to open and save files, to batch convert 
files to JPEG, and to display multiple images in a selected order.

For more information, select the File menu command name.

Open
Save
Save All Options
Delete
Batch Compression
Slideshow
Exit



Edit Menu

The Edit menu includes commands that enable you to transfer images to and from the 
clipboard, to change the color components of an image, and to manipulate the image.

For more information, select the Edit menu command name.

Copy
Paste
Crop
HSV Adjustment
Color Balance
Contrast Enhancement
Rotate
Flip Horizontal
Flip Vertical
Resize



Options Menu

The Options menu includes commands that let you determine how other commands operate.
The settings for the options can be saved with the Save All Options command.

For more information, select the Options menu command name.

8-Bit Bitmap
Dither24to15
Auto-resize
Show Scroll Bars
JPEG Options
Memory Options
Slideshow Options



File Open command (File Menu)

Select the name of a file to display and the file format which is the JPEG File Interchange 
Format (JFIF), TIFF, GIF 87a/89a, uncompressed Targa, PCX, or Windows BMP.    Selecting the 
JPEG Preview file type will display a JPEG image with 1-pass quantization and dithering off.  
This combination will display an image 25-50% faster than 2-pass quantization with 
dithering on. All 24-bits per pixel-images are loaded into either an 8-bit or 24-bit bitmap 
which is determined by the 8-bit Bitmap option.    Other bits per pixel-formats are 
automatically stored in an 8-bit bitmap.



File Save command (File Menu)

Select the name of the output file and the output format, which is the JPEG File Interchange 
Format(JFIF), TIFF, GIF 87a, uncompressed Targa, PCX, Windows BMP or OS/2 BMP.    When 
you save an image, the bits per pixel of the output file is the same as the bits per pixel of 
bitmap that is currently displayed unless the bits per pixel of the output format is fixed (e.g.,
JPEG or GIF).



Save All Options command (File Menu)

This will save all the WinJPEG options to a file named "winjpeg.sav" in the same directory as 
the WinJPEG executable.    When WinJPEG is initially loaded, the options will be loaded if 
"winjpeg.sav" exists.



Delete command (File Menu)

This menu command lets you delete the file containing the currently displayed image.    
WinJPEG will prompt you for confirmation before deleting the file.



Batch Compression command (File Menu)

Select GIF and TARGA files to compress to JPEG format with the options specified in the JPEG 
Options dialog.    The list box on the left displays the files in the current path and the list box 
on the right displays a list of files to be converted.    To add file(s) to the latter box, select the
file(s) you want to convert and press the Add button.

If you decide to abort the conversion while it is in the process of converting, click on the 
window with the left mouse button, click on the "Yes" button in the confirmation dialog, and 
the conversion will halt after the current file is completed.

The output file(s) will have the same name as the input file(s) except that they will have a 
".jpg" extension.    Also, the output file(s) will be placed in the same directory path in which 
the input file(s) were located.

See also JPEG Options.



Slideshow command (File Menu)

Select the JPEG, TIFF, GIF, Targa, PCX, and Windows BMP files to display in a slideshow.    The 
order in which you add the files will be the order in which they are displayed.

After a picture is loaded and displayed, if Automatic Slide Advancement is selected, there
will be a user-selected delay before the next picture is loaded.    To advance to the next 
picture before the delay has elapsed, click on the window with the right mouse button.    If 
Manual Slide Advancement is selected, WinJPEG will wait until you click with the right 
mouse button before advancing to the next picture.

If you would like the slideshow to continue from the beginning of the list after the last picture
is displayed, check off the Cycle Slideshow menu option.    

To abort the slideshow, click on the window with the left mouse button, click on the "Yes" 
button in the confirmation dialog, and the slideshow will stop after the currently loading 
picture is displayed.

See also Slideshow Options.



Exit command (File Menu)

Exit from WinJPEG.    While WinJPEG is compressing/decompressing an image, you can exit by
using the Close command in the system menu.



Copy command (Edit Menu)

If a region of the image is selected (see Selecting a Region to Crop or to Copy), copy that 
region into the clipboard.    Otherwise, copy the entire image into the clipboard.    WinJPEG 
posts the image in Windows bitmap and Device-Independent Bitmap(DIB) formats.



Paste command (Edit Menu)

Paste an image from the clipboard.    The clipboard must contain either a Windows bitmap or 
a Device-Independent Bitmap(DIB).



Crop command (Edit Menu)

If a region of the image is selected (see Selecting a Region to Crop or to Copy), keep that 
region and discard the image outside of    the selected region.



HSV Adjustment command (Edit Menu)

Use the scroll bars to adjust the amount of hue, saturation, and value/brightness in an 
image.    A value of 0 on the scroll bar means that there is no change in the corresponding 
color component.    When the value is increased or decreased, the color component is 
increased or decreased, respectively.    Warning: the HSV calculations are very slow in 24-bit 
mode.



Color Balance command (Edit Menu)

Use the scroll bars to adjust the amount of red, green, and blue in an image.    A value of 0 
on the scroll bar means that there is no change in the corresponding color component.    
When the value is increased or decreased, the color component is increased or decreased, 
respectively.



Contrast Enhancement command (Edit Menu)

Use the scroll bar to adjust the amount of contrast in an image.    A value of 0 on the scroll 
bar means that there is no change in the contrast.    When the value is increased or 
decreased, the contrast is increased or decreased, respectively.



Rotate command (Edit Menu)

Rotate the image clockwise by 90 degrees.



Flip Horizontal command (Edit Menu)

Flip the image around the vertical axis.



Flip Vertical command (Edit Menu)

Flip the image around the horizontal axis.



Resize command (Edit Menu)

Change the spatial resolution of the displayed image.    Common sizes such as 640x680, 
800x600, 1024x768, and 1280x1024 can be easily selected.    The Maximize Fit on 
Desktop option will resize the image into the largest possible window that will fit on the 
desktop while keeping the aspect ratio, the ratio between the original width and height.    
Also, a custom size can    be manually entered.    If Keep Aspect Ratio is enabled, only one 
dimension needs to be entered because the other one is automatically changed to maintain 
the aspect ratio.



8-bit Bitmap command (Options Menu)

When you load a JPEG, 24-bit TIFF, 24-bit Targa, 24-bit PCX, or 24-bit Windows BMP image 
with this menu item checked, WinJPEG will quantize the number of colors to 256 before 
displaying the image.    If this menu item is unchecked, the image will be loaded into a 24-bit
bitmap with no quantization.



Auto-resize command (Options Menu)

When this option is checked, WinJPEG will automatically resize the window so that the image
will fit just inside the window.    When an image is initially loaded, the window size is changed
so that the largest possible portion of the image is displayed.    When you change the window
size so that it is larger than the image size, the window will    be resized so that it just fits 
around the image.    Also, scroll bar(s) are activated if they are needed.



Dither24to15 command (Options Menu)

This option is available only if you are using a 32k color or 64k color display mode.    When it 
is checked and the 8-Bit Bitmap option is off, JPEG, TARGA, or 24-bit Windows BMP images 
will be dithered to 15-bits per pixel so that they can be displayed properly.



Show Scroll Bars command (Options Menu)

This option is available only if auto-resize is off.    It lets you choose whether or not the scroll 
bars are activated.



JPEG Options command (Options Menu)

2-pass(Heckbert) quantization produces better looking output than 1-pass quantization and
it is slower.    Also, 2-pass quantization uses more memory so it may be even slower 
because WinJPEG will swap to hard disk when it runs out of physical memory.    The output of 
1-pass generally looks more grainy.

Dithering uses available colors in a palette to simulate additional colors.    The dithering 
method that WinJPEG uses is called Floyd-Steinberg Dithering.        Dithering is useful 
when quantizing to 256 colors or less but it is not needed for a true-color (24-bit) display.    
You may want to turn off dithering since it sometimes causes a grainy output image.

The Quality Factor, an integer between 0 and 100 inclusive, determines the tradeoff 
between the output file size and the output image quality.    If you choose a high quality 
factor, the image quality will be high but the file size will be large.    A lower quality setting 
will yield a smaller file at a cost of lower fidelity.    Since the JPEG algorithm is lossy, a quality 
factor of 100 will not give you a losslessly compressed image.

The Smoothing Factor, also an integer between 0 and 100 inclusive, determines the 
degree of smoothing to apply to an image before compressing that image with JPEG.    The 
higher you set the factor, the higher the degree of smoothing that is applied.    A smoothing 
factor of 0 means that no smoothing is performed.    Smoothing removes noise introduced 
when an image is dithered, and, in turn, smoothing produces a smaller JPEG file.    It should 
be used for only dithered images, like photographic GIF pictures.    Generally, a factor 
between 10 and 50 removes the dithering noise from an image.

Entropy Optimization produces a smaller JPEG file but it takes more time to encode the 
image. 



Memory Options command (Options Menu)

When WinJPEG needs more memory, it can use virtual memory, selected by the Available 
Memory button, or it can use temporary files, selected by the Temporary File button.    If 
the former option is selected and WinJPEG runs out of virtual memory, temporary files will 
automatically be used.

Temporary files are created in the directory chosen by the user and they are deleted when 
WinJPEG is done with the memory or when the user aborts decompression/compression of an
image by closing the program.

In general, the Available Memory should be selected when your system has at least 8 Mb 
of RAM, and the Temporary File should be selected when you have little RAM or you are 
multitasking memory-intensive programs.



Slideshow Options command (Options Menu)

When a slideshow is running, the Cycle Slideshow option determines whether or not a list 
of images are continuously displayed in a cycle.    If this option is on, the slideshow returns 
back to the first picture after the last one is displayed and continues to display all the 
images in a selected list until you abort the slideshow.

The Slide Advancement options determine how to advance to the next image in a 
slideshow.    In Manual mode, WinJPEG will wait until you click with the right mouse button 
before advancing to the next picture.    In Automatic mode, there will be a user-selected 
time delay before the next picture is loaded.    To advance to the next picture before the 
delay has elapsed, click on the window with the right mouse button.    The Delay can be set 
to a value between 0 and 60 seconds.



JPEG

Joint Photographic Experts Group (JPEG)    refers to a still-picture compression standard that 
specifies several modes of operation.    The mode used by the Independent JPEG 
Group's(IJPEG) software, which is incorporated into WinJPEG, is sequential buildup;    in this 
mode,    each component of an image is encoded in a left-to-right and top-to-bottom scan.    
Sequential mode is lossy, which means that when you compress an image, you will lose 
information.    That is, when you decode the compressed image, the decoded image will not 
exactly match the original.    One reason that sequential mode JPEG is lossy is that the 
algorithm compresses an image by removing visually insignificant information, colors that 
the human eye cannot detect.



Image File Formats

For more information, select an image file format.

JPEG File Formats
Tagged Interchange File Format (TIFF)
Graphics Interchange Format (GIF)
Targa
PCX
Windows BMP and OS/2 BMP



JPEG File Formats

The JPEG committee has not specified a standard file format, and consequently, many 
applications of the JPEG algorithm use their own proprietary format.    WinJPEG uses the JPEG 
File Interchange Format(JFIF) which transports only pixel information.    JFIF is supported by 
the IJPEG Group's software and other programs based on their code.

Handmade Software's GIF2JPG and Image Alchemy by default use a proprietary JPEG format 
that is not compatible with the JFIF standard.    This proprietary format is not supported by 
WinJPEG.    When you use GIF2JPG, remember to use the "-j" option to produce a JPEG file 
that is compatible with the JFIF standard and viewable with WinJPEG.

However, the GIF2JPG's "-j" option doesn't always produce a file in JFIF.    If you have to use a 
DOS converter,    we recommend that you use the IJPEG Group's cjpeg program.      Otherwise,
you should use WinJPEG's Batch Compression feature, which performs the same task as 
cjpeg except that only GIF and TARGA images are supported.



Tagged Interchange File Format (TIFF)

WinJPEG supports a subset of the TIFF 6.0 specification.    WinJPEG can view TIFF files stored 
with 1, 2, 4, 8, or 24 bits per pixel.    WinJPEG can read TIFF images stored in strip format, in 
which the image is divided into horizontal strips of pixels, and tile format,    in which an 
image is divided into rectangular grids of pixels.    The compression modes LZW and Packbits 
can be read as well as uncompressed TIFF images.

WinJPEG can save uncompressed or LZW compressed TIFF files with 8 or 24 bits per pixel.    
TIFF files are saved in strip format.



Graphics Interchange Format (GIF)

WinJPEG can view interlaced/non-interlaced GIF87a and GIF89a files and it can save non-
interlaced GIF87a files.    If a GIF89a file contains more than one image, it will display the 
first image in the file.

There are some GIF files that display with no errors under other image viewers but when 
they are viewed under WinJPEG, a "Premature End of GIF" error message is displayed .    
These GIF files are probably corrupt; the GIF decoder routines in WinJPEG are stricter than 
those used in other viewers. If you want to avoid seeing this error message when you load a 
corrupt GIF, load it into WinJPEG, and overwrite the corrupt file by saving the displayed 
image as a GIF.



Targa

WinJPEG can view uncompressed TARGA files stored with 8, 15, 16, 24, or 32 bits per pixel 
and it can save uncompressed TARGA files with 8 or 24 bits per pixel.



PCX

WinJPEG can view PCX files stored with 1, 4, 8, or 24 bits per pixel.    If a 1, 4, or 8 bits per 
pixel PCX file does not have a valid palette, WinJPEG will use a default palette.    It can save 
PCX Version 5.0 files with 8 or 24 bits per pixel.



Windows BMP and OS/2 BMP

WinJPEG can view Windows BMP files stored with 1, 4, 8, or 24 bits per pixel and can view 4 
or 8-bit Windows BMP files that are run-length encoded(RLE).    It can save uncompressed 
Windows or OS/2 BMP files in 8 or 24 bits per pixel and can save 8-bit Windows BMP files 
with RLE.

Note that some graphics viewers use the file extension ".RLE" for run-length encoded 
Windows BMP files.    WinJPEG uses the ".BMP" extension as a default for such files.



How to Register

If you use WinJPEG for more than 14 days, you are expected to register WinJPEG.    When you
register, you will receive the latest 286 and 386 versions of WinJPEG, a user manual, and a 
collection of JPEG images (we will put as many as we can fit on 2 720k 3 1/2" floppies, on 1 
1.44M 3 1/2" floppy, or on 4 360k 5 1/4" floppies).    Also, the registered version does not 
have the reminder-to-register screen at the start.

The registration fee is only $20.    MA residents, add 5% sales tax to the registration fee.    US
residents, add $3 for shipping and handling; non-US residents, add $8 for shipping and 
handling.    If you want WinJPEG e-mailed to your account instead of having it physically 
mailed to you, there is no extra shipping charge.    For e-mail registrations, you need a utility 
called "uudecode" to decode the uuencoded file that we e-mail to you.    Note that the 
uuencoded file is rather large; it is greater than 500k for WinJPEG v.2.1.    Compuserve users 
may find it less expensive to receive WinJPEG via U.S. Mail.

Registrations with the incorrect fee or with non-US currency will be returned.

Because of the lengthy time it takes to produce a new version and to distribute it to 
registered users, updates are no longer free.    Updates will cost $5.    Those who initially 
received version 1.6 when they registered can obtain the next update for free.    Shipping 
fees described above apply to updates as well.    Updates are available when you see a new 
shareware version.

To register, complete the order form and send a check in US funds to:

            Norman Yee
            58 Chandler St.
            Boston, MA 02116



Reporting Bugs

If you find a bug in WinJPEG, we would appreciate it if you would inform us of the bug 
through one of our e-mail accounts:

Norman Yee Ken Yee
nyee@osiris.ee.tufts.edu kenyee@ksr.com

When you send us a bug report, include a description of    the procedure for reproducing the 
bug and a description of your system configuration(hardware and software).



License Agreement (applicable to registered users)

You are licensed to single-copy use of WinJPEG; this means that you can install your 
registered version of WinJPEG simultaneously on one computer at work, one computer at 
home, and one portable computer, if only one copy is in use by the registered individual at a
time.    You may make copies of the registered WinJPEG disk as necessary for normal backup 
purposes; you agree not to make any copies of the printed WinJPEG manual or the registered
version of WinJPEG for others. 



Disclaimer

The authors of this program accept no responsibility for damages that are caused by this 
program and make NO WARRANTY or representation, either express or implied, with respect 
to this software.    This software is provided "AS IS," and you, its user, assume the entire risk 
when you use it.
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WinJPEG Features

WinJPEG v.2.1 is a shareware image viewer with image processing and conversion 
capabilities    for Microsoft Windows 3.x.    It has the following features:

- display JPEG, TIFF, Targa, GIF, PCX, or Windows BMP images
- export an image to JPEG, TIFF, Targa, GIF, PCX, Windows BMP, or OS/2 BMP
- display of 24-bit images with 1-pass or 2-pass(for JPEG only) quantization and Floyd-

Steinberg dithering
- color balance: red, green, and blue adjustment
- hue, saturation, and brightness adjustment
- image rotation, vertical or horizontal flip, image resizing, and image cropping
- batch file compression of GIF or TARGA files to JPEG File Interchange Format (JFIF)
- slideshow: display selected files sequentially with a cycle option
- copy a portion of or the entire image    to the clipboard, paste an image from the clipboard
- support for Windows 3.1 features like drag-drop and common dialogs
- support for file name extension association and starting a slideshow from the command 

line

There are two versions of WinJPEG: a 386 version for 386's or better and a 286 one for 286's 
or better.    The shareware version is a fully functional 286 version.    The 386 version can be 
obtained by registering WinJPEG.    See How to Register for more information.



Drag-drop Support

If you are using Windows 3.1, when you drag one or more files from File Manager to an open 
WinJPEG and drop them there, WinJPEG will automatically enter the slideshow mode and 
display those files in the order in which they are listed in File Manager.    There is a delay, 
which can be set in the Slideshow dialog box, between displayed pictures.



Selecting a Region to Copy or to Crop

To select a region of the image,    click on the image with the left mouse button.    While 
holding down that button, move your mouse until the rectangle surrounds the desired 
region, and then release the mouse button.    The dimensions of the selected region are 
displayed in the center of the indicated region.



Converting File Formats with WinJPEG

Because most photographic images with 2 colors(monochrome) or 16 colors do not have 
decent fidelity, WinJPEG does not fully support these color modes.    If you are running 
Microsoft Windows in a display mode with less than 256 colors, WinJPEG will warn you and 
advise you to use a display mode that supports at least 256 colors.    

On the basis of the display mode, the image format, and WinJPEG options, WinJPEG will 
quantize or dither an image before displaying it.    Regardless of these factors, when WinJPEG
loads images stored in 1 or 4 bits per pixel, it will losslessly convert them to an 8 bits per 
pixel format.    

If you are using a 16 color display driver and you enable the "8-bit Bitmap" option, WinJPEG 
will quantize an image to 16 colors in some cases.    We recommend that you do not use this 
color mode to convert images from one format to another.

In 256 color video mode or better, with the "8-bit Bitmap" option enabled, all 24-bit 
images(i.e. 24 bits per pixel) are quantized to 256 colors before displaying them.      With this 
option enabled, you can convert a 24-bit image to an 8-bit one.    1, 4, and 8-bit images are 
automatically stored in 8-bit format with no data loss and displayed.    If you are converting a
24-bit image to a 24-bit output format in this color mode, you should turn off the "8-bit 
Bitmap" option before loading that image.    

With a 32k or 64k color Windows video driver, the "Dither24to15" option dithers a 24-bit 
image to 32k colors for display; it should not be enabled when you are performing file format
conversion.

The preceding conversion restrictions do not apply when using Batch Compression to 
compress images to JPEG format.    They only apply when the Save option is used from the 
menu.

When WinJPEG quantizes or dithers an image for display, information in that image is lost 
and WinJPEG will warn you when you try to save that image.



Notes about OS/2 2.0

When you run WinJPEG under OS/2 2.0, WinJPEG cannot allocate more than 1 Mb of 
contiguous memory at a time.    Because of this limitation in OS/2 2.0, WinJPEG cannot 
allocate enough contiguous memory if the image is too large.    In addition, this limitation will
cause the JPEG code to use temporary files most of the time.    OS/2 2.1 allows Windows 
applications to allocate more than 1 Mb of contiguous memory and it fixes this problem.




